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Your Mind Mapping creativity enhancing tool

by NovaMind Software

Produce unique, information rich, vivid solutions for
enhanced creative thinking and compelling presentations.

Smooth curves and colorful pictures create powerful images
for your brain to remember. Branches can be contoured to
your liking for a Mind Map that will reflect your own distinct
style. Our unique Branch Proposal System suggests new
directions for your thoughts, generating additional ideas and
prompting exploration of more options.

The information stored in your mind map is compact and
meaningful, allowing you to see the important issues,
organize your thoughts, and solve problems quickly and
effortlessly. The solutions are new and effective, and can
easily be presented to others using graphical or text
representations. NovaMind makes Mind Mapping intuitive
and fun.
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1 All about Mind Mapping

This section gives a brief overview of Mind Mapping, how you can benefit from using it, and an
introduction on how to Mind Map. There is more information available from the NovaMind web site.

1.1 What is a Mind Map?

The Mind Map is simple to make, because it works just like your brain and memory.

So how does it work? A Mind Map is: 

1. A way of remembering information 
Information is presented in a form that is logical and easy to remember. Recalling a branch leads to
memory of the sub-branch details. Students can put information into this form for recall in
examinations. 

2. A way of generating ideas 
You have one idea but it seems to go nowhere. Make it the title of a mind map. The branches prompt
you to add ideas at another level. A structure emerges. Soon that idea has become a whole concept.
The mind map keeps all your ideas in front of you in a clear form. Each new idea is a center of thought
for more new ideas. 

3. A way of organizing thoughts 
When you have a number of thoughts and want see how they relate to each other, starting a Mind Map
helps get them organized. You will be able to pick out the main thoughts and see how the others relate
to them. 

4.Works from overview to details 
The main branches convey the overall picture, while the sub-branches give the key points or details.
You can see quickly how items are related and inter-dependant. The mind map brings clarity to
complex material. 

5. Focuses your mind on the main issues 
The mind map enables you to see at a glance, what is important. As you work, your whole brain and all
your skills come into play. Mind mapping is fun. 

6. Helps you to solve problems 
The very act of making a mind map around a problem, helps you to see possible solutions and to
select the one that will meet all your criteria. 

7. Compact 
By making use of color, shape, style, layout and fonts, a Mind Map can hold a large amount of
information in a small space. A whole complex concept can be presented on one page. 

8. Graphical 
Mind Maps give the whole story in one picture. Your map can be easily read by others. 

9. Uses words 
Using text allows your ideas to be expressed accurately. You can use your own language. You can
form a document from your mind map. 

10. Uses color 
Ideas can be linked by using the same shape for their boxes, or the same color for the branches.
Emotions can be conveyed, and importance stressed. 

http://www.nova-mind.com
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11. Can be used for training and job instruction 
Each branch is an important step in an operation and the sub-branches are the key points in each
step. 

1.2 What would I use a Mind Map for?

Problem solving 
Create a mind map including all the factors involved in the problem. The map will prompt new aspects.
Include them all as branches. New pathways will open up. Your linear thinking will now become lateral
thinking. Give priority to the important issues by color, shape or number. Now weigh up the options and
proceed with the best solution. 

Learning 
Use a map to take notes of a lecture. Main branches are the important aspects, child branches, the
detail. To summarize the contents of a book, the parent branches are like chapter divisions, and the
detail is shown in the offspring branches. 

Use your mind maps for learning. A single map can cover much information. The layout helps you
focus on the main issues. 

Thinking 
Mind maps give vitality to information, and help your mind concentrate. Ideally suited to brain storming,
ideas can be quickly recorded so that the flow is not interrrupted. 

Association between ideas is immediately obvious, and everybody's creative force is brought to bear
on the subject. When the ideas dry up, try the "what if?" and reversal approaches. Soon your thinking
is clear and your ideas can be put into practice. 

Organizing 
When you list the things that need to be done, the order of the branches gives the succession of tasks
and the proirities. Sub-items are shown as sub-branches so that no key activity is lost. 

The map highlights the resources needed to carry out the total operation. 

Communicating
Talks and presentations become clear and concise when directed by a mind map you have prepared
in advance. You are kept on track; your time is balanced over the main topics and the audience can
see the whole picture. The presentation will have an informality that reflects the fact that you have
organised the material well. 

Agendas can be mind-mapped and notes of the proceedings jotted on your mind map for formal
recording in minutes. 

Technical documantation becomes clear when a mind map shows the main operations and the
details. 

Teachers and lecturers can use the mind map to plan lessons and series of talks. 

1.3 What are the benefits of Mind Maps?

Scientists have identified four main areas of our conscious brain function. The mind mapping process
stimulates all four areas to produce a unique map. 

We use logic, lines, numbers, words, lists, rythm, colour, daydreaming, and imagination to produce a
whole picture of our thinking on the subject - a mind map. The use of all these brain functions together
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produces a great feeling of achievement. 

1.4 Why use Mind Mapping software?

Quicker and easier to create Mind Maps 
A few key strokes/mouse clicks, and you create branches as you need them, and type in the
information. 

Can be represented in multiple formats 
A Mind Map created with NovaMind can be printed as text or as a picture. The text version preserves
the structure and order of the branches, and indents them appropriately. You can reference branches
by number. 

You can export the Mind Map from NovaMind in several formats for working with other software. 

For a colorful memory jogger 
It is easy to drag the branches to the place you want them. You can choose branch colors, let the
"Rainbow Colours" operate, or combine these methods. 

To add visual interest, adornments may be included, and branches may be shaped from line to oval,
rectangle or image. 

Notes and graphics can be added to extend the visual appeal and information of the branches. The
result is an easily remembered picture. 

Easy to share with others 
Email your Mind Maps to others, or print them in different formats. Thus, NovaMind maps may be
shared more easily than those we drawn by hand. 

Spend more time on the contents rather than drawing 
NovaMind will draw the branch lines neatly, color them automatically, and draw the shapes for your
branches. You can concentrate on the material. 

When all has been recorded, you can easily make it look the way you please. 

Result is neat and professional 
The NovaMind software makes you an artist. With it, you can create a stunning Mind Map which looks
professional and convincing. 

Easy to edit 
Use NovaMind to space the branches according to the number of child branches. Let the software do
the tricky, time-consuming work. Editing can be done as you go or left to the end. No rubbing out - no
re-spacing - no frustration. 

Link descriptive text to branches for printing 
With NovaMind, formatted text may be attached to any branch. This text can be printed with the full
text outline of the Mind Map. No extra documents are needed as in traditional mind mapping. 

Live links to other Mind Maps and documents 
In NovaMind, you can create hyperlinks on any branch, which can open other NovaMind documents on
your machine or over the Internet, and select the branch you want. 

You can link to any file on your own machine or over the Internet, and NovaMind will open that file in
whatever program you have set up to open that type of file. 
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You can even have the hyperlinks compose a mail message within your eMail program. 

1.5 How to Mind Map

· Gather information for your Mind Map 
· Select the topic - one or two words - type in box 
· Start at the center, perhaps with an image to represent the topic 
· Add the top level ideas - a main branch each 
· Capture all the ideas first; organize & elaborate later 
· Each Mind Map yours - it is neither right nor wrong 
· Add emphasis with color, images and layout 
· Use sub-branches to include secondary items 
· Humor, colors and layout will make it easy to remember.

2 Getting Started

This section tells you how to get up and running with NovaMind.

2.1 Installation

To install NovaMind, firstly download the NovaMind application from the Downloads section of the
NovaMind web site. It will come as an  MSI file, something like NovaMind4Platinum432.msi (where
432 would be the version number).

Double click on the MSI file to start the installation.

The installer will be signed using our legal company name NMS Global Pty Ltd, and will look
something like this:

The first screen that will appear looks like this:

http://www.nova-mind.com/Downloads
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Click on the Next button to show the next screen of the installation procedure:



Getting Started 6

© 2007 NovaMind Software

You will need to click on the I Agree option to accept the license agreement and continue. Make sure
you have read and understand the license agreement before agreeing to it. Click on the Next button to
go on to the next screen:
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The default installation location is usually correct for most people, but if you need to install somewhere
else, choose the installation location where you would like NovaMind installed by using the Browse
button or typing in the new location. 

If you are short of disk space, you can see exactly how much disk space is available on all your disks
and how much will be used by the installation, so you can choose the best place to install. 

If you attempt to install on a disk that doesn't have enough space, you will be told and will  need to
either choose a different installation location or free up some space on your disk.

Choose whether to install for everyone on your computer or just for you.

Click on the Next button to go on to the next screen of the installation:
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You are now ready to start the installation of the files on to your computer. If all is OK, click on the Next
button and the installation will commence and you can follow the progress with the progress bar.
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Once the installation is complete, you will see the following screen:
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This means that the installation has completed successfully. Note the message at the bottom of the
screen to use Windows Update to check for .NET updates. NovaMind requires .NET 3 to run, and
from time to time there may be bug fixes for this framework released by Microsoft. In most cases you
would have Windows Update running automatically to check for updates, but if you don't you can run it
by using the Control Panel / Security / Check for Updates option. If you didn't have .NET 3 already
installed when you install NovaMind, the installer will direct you to the download page so you can
download and install it.

Command line installation options

The .MSI file can be installed using the msiexec program from the command line, with the relevant
command line options. Please see the Microsoft documentation of the options 

Sample Mind Maps

The installer installs a number of sample Mind Maps, and puts a link to them in the NovaMind Software
group in your start menu. These files will have already been registered to NovaMind, so you can just
double-click a file and it will open in NovaMind.

Other Downloads

Note that there are also other downloads of the Suggesterator  as well as multiple Graphics
Libraries  with over 2,300 high quality images for you to use in your Mind Maps. These are installed
by downloading the installer files and running them.

Uninstallation

If you need to uninstall NovaMind at any stage, you can either double-click on the MSI installer file

33
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again, and you will be given the option to either repair or uninstall NovaMind, or you can remove it
through the control panel.

To remove NovaMind using the control panel, if you are using Windows XP, go to the control panel
and use the "Add and Remove Programs" option to remove the old version.

To remove NovaMind using the control panel, if you are using Windows Vista, go to the control panel
and use the "Uninstall a Program" option under the programs section, and select NovaMind from the
list, and then click on the Uninstall option at the top of the list of programs to remove it.

2.2 User Interface

The NovaMind user interface is implemented based on the Microsoft Fluent user interface concept.
Here are some key aspects of the user interface:

1. The Ribbon Bar which holds all the commands you will use to work with your Mind Map.
2. Tab - the ribbon bar has a number of tabs, each covering a functional area of the program.
3. Contextual Tab - a tab that only appears when appropriate. In this case it is the formatting tab that

only appears when you have a branch or shape selected.
4. Command Group - a box that groups a collection of related commands.
5. Commands - each icon or button represents a single command. Some commands are also shown

on popup menus.
6. Menu Triangle - Indicates where there is a menu which will be shown when you click on the triangle.

When you put your mouse over the button, you will either see a single button with the menu triangle
on it, or a split button with one part of the button having the menu triangle on it. If the button is not
split, it will always show the menu when clicked. If it is split, it will issue a normal command when
you click on the main button, and only show the extra options in the menu if you click in the part of
the button with the menu triangle on it.

7. Dialog Box Launcher. This button launches a dialog box with detailed commands related to the
command group. You can keep the dialog box open if you choose.

8. NovaMind Application Menu. This button shows all the file and document related commands.
9. Help. Click here to show the options for accessing the help documentation, visiting NovaMind,

licensing, and sending feedback to NovaMind.

2.3 Creating your first Mind Map

The following describes the basic creation of a Mind Map. There are a number of ways of
accomplishing these tasks (shortcut keys , context sensitive menus  etc), which are dealt with in
other places in the documentation. 

When you start NovaMind, it will initially have a Mind Map already created for you, or you can create a
new file by clicking on the NovaMind Application Menu, selecting File / New Document. If you would
like to use one of the supplied templates you could use the New Document from Template option and
choose a suitable template for your needs. For the moment, we will assume that you are starting with a
blank Mind Map.

54 51
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Type in the Mind Map title. 

Your Ribbon Bar should be showing the Home tab, so click on the option to add a Child Branch in the
Insert group. 

If you want to add a different type of branch than the default branch type shown, click on the Menu
Triangle and select the type of branch to add.

You can also create child branches by pressing Insert, and
sibling branches (i.e. at the same level) by pressing Enter
(unless you have changed the key bindings in the Options
)

Type the title of the branch. 

You can continue adding branches using the Insert / Branch option or Insert / Child Branch option.

You can also add child branches of the default type using the Suggesterator  if you have it installed. 

Repeat until you have completed adding the information you want in your Mind Map.

If you want to add text to a branch that you are currently not editing, select it by double-clicking on the
branch text then typing.

2.4 Saving your first Mind Map

To save your Mind Map, select the NovaMind Application Menu (the round button with the NovaMind
logo in it) / Save option from the menu (or use Ctrl+S). Choose the location to save the file. NovaMind
files are saved with the filename extension nmind. 

In the General Options  pane, you can set NovaMind to save your files automatically at set
intervals

When you first run NovaMind, it is set up so that it saves a backup copy of the previous
version of your files with a Filename.nmbak name. If you don't want this to happen, you can
turn it off in the General Options  pane. If you need to restore from a backup file, you just
need to rename it with a .nmind extension and you will be able to open it.

3 Licensing

This section tells you all about the different types of licenses, how to enter license keys etc.

56
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3.1 Software End User License Agreement

Rather than reproduce the whole End User License Agreement here, you can view it on our web site
at http://www.nova-mind.com/EULA.html. You must agree to the terms of this agreement to use the
software.

3.2 How to purchase a license

You can either purchase a license from the NovaMind web site, or directly from within the NovaMind
application. 

Purchasing from the NovaMind web store

From the Web Site, click on the Store tab at the top of the web page, which will take you to the web
store, where you can add NovaMind products to your shopping cart and complete the checkout
process.

Enter your details, including any coupon you may have for an educational user discount (which you
must apply for prior to purchasing - we can't process the discount when you have already purchased,
as we get charged transaction fees for the full purchase plus the partial refund, and it all ends up
costing too much in both time and fees).

If you would like to also receive all of the downloads on CD, please select the CD option. Note that
everything on the CDs is available for download from our web site, and this is just something we offer
for your convenience.

If you would like to purchase something else in this transaction, such as paid support or Mind Mapping
books, add the other items to your shopping cart before you check out.

Enter your personal and credit card information (if paying by credit card) and click the Complete
Purchase button.

You will see the full order details including the final price including any applicable taxes in your chosen
currency prior to submitting your order for processing. Note that the base currency for all our
transactions except PayPal is US dollars, and other currency amounts are shown as indicative pricing
only, and although the amounts are unlikely to vary much at all, any variance is outside our control.
PayPal payments are made in Australian dollars, and amounts will be converted automatically at a
competitive rate by PayPal.

Once your order has been processed, you will see the receipt on your web browser with your
NovaMind license key in it. This information will be emailed directly to you as well.

You will see mention in a number of places on
our web site of a product called Merlin. This is
a Mac OS X only project management
application and will not run on Windows.

Purchasing from within the NovaMind application

To purchase from within NovaMind, select the Licence option from the Help menu, and click
"Purchase". You will be taken to our online store to complete the purchase.

http://www.nova-mind.com/EULA.html
http://www.nova-mind.com
http://www.nova-mind.com
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3.3 Entering a license key

When you purchase a license key from the NovaMind web site, or need to re-enter the license key
(after a re-install etc), Select the "Help / License" menu option, then click the "Enter New License"
button. Licenses are valid for all releases within a major revision of the product edition  you have
purchased. For example, a NovaMind Express 4 license key will work in NovaMind Express 4.3.2 but
not in NovaMind Express 5.0 and not in NovaMind Pro 4.3.2. Major revision (e.g. v4 to v5) upgrades
are paid upgrades.

The licence key you received from NovaMind will be a series of letters and numbers. The best way to
enter this is to copy and paste it in rather than typing it. The license key is not case sensitive.

Enter your first name, last name, email and company name as well as the license key.

If you would like to receive our newsletter, leave the "Register for MindMap Connection Newsletter"
option checked. Note that this will add you to the newsletter if you have not already subscribed to it - if
you do not check this option, it will not remove you from it if you are already on it. All our newsletters
include a link to manage your subscriptions, and you can click on the link to remove yourself from the
list if you so desire.

Click the Activate button to complete the registration and activation process. An internet connection is
required for activation. We respect your privacy and will not release your information to anyone or use
the information for any purposes other than NovaMind related messages.

NovaMind will check that the license is valid, and has not expired, and if all is OK, will accept the
license and show you the license details. 

3.4 Demo mode

When you first download NovaMind, it comes with a 30 day trial license so that you can try all the
features (30 days from the first time you run NovaMind). Each time you start NovaMind, it will tell you
how long you have remaining until the end of the trial period.
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You should purchase before the end of the trial period to ensure uninterrupted operation.

If you have still not entered a license key by the time the trial period is up, NovaMind will drop back to
its second level demo mode where you will not be able to save or export the Mind Maps or Scripts you
have created. You will be able to print, however there will be an UNLICENSED watermark on your
output which will be removed only once a license is purchased.

3.5 Types of license

Edition Information

Make sure you purchase the most appropriate version of NovaMind for your needs. Information about
the different versions is below, and there is more information on the different feature sets at http://
www.nova-mind.com/Features.

NovaMind Express

NovaMind Express is the lowest level of NovaMind, and contains all the things you need to get started
Mind Mapping. It does not have all the advanced features of NovaMind Pro and Platinum, like multiple
Mind Maps in a single file, detachable inspector palettes, presentation mode, screenwriting, project
related information, and only has basic import and export capabilities.

NovaMind Pro

NovaMind Pro has many more features than Express, and is designed for the frequent Mind Map user,
and is suitable for general business use. It has the ability to create multiple Mind Maps in a single
document, hyperlinks and checkboxes on branches, more advanced imports and exports, detachable
inspector palettes, and the ability to create your own reusable templates etc.

NovaMind Platinum

NovaMind Platinum is the top of the range Mind Mapping application, designed for serious business
users, project planners, presenters, and screenwriters. It has all the features for project planning and
task information recording, the complete presentation module for doing professional presentations, the
screenwriting module for writing screenplays, and high resolution graphics libraries with up to 8 times
the number of pixels, enabling you to create even more stunning Mind Maps.

License Types

Single user license 
A Single User license allows a single user to use NovaMind. You may use this license for either a
single computer where different people use NovaMind on that computer at different times, or for a
single user who has several computers. You may not have more than one person using one single-
user licence at any given time. 

For single user licensing, each installation and user will require the entry of the license key. Free
upgrades do not require re-entry of the license key as this information is saved under your user
settings. 

Multi-user license 
When you purchase a license for multiple users, you still receive a single license key. You can enter
that license key on as many computers as you require, so long as the maximum number of concurrent
users does not exceed the number of users you have licenses for.  

http://www.nova-mind.com/Features
http://www.nova-mind.com/Features
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Site license
A site license is the same as a multi-user license, but it doesn't have a limit on the number of people
who can access it. Site licenses are valid for all the users at one physical site.

Windows and Mac
The same license keys are used for Windows and Mac, so if you have a single user license for
instance, and you have a Mac at home and a PC at work, you will be able to use the same license in
both places so long as you only use one copy of NovaMind simultaneously.

Support & other products
We offer both a high quality free support service, and a paid support service which puts you at the
head of the queue to get your issues resolved quickly, and gives you extra information and lines of
communication with us. See our web store for a full description of our support services.

The creator of NovaMind and founder of the NovaMind company, Gideon King, has written a book
entitled "Teacher's Guide to Mind Mapping", which is available through our web store. He is currently
writing other Mind Mapping books.

3.6 Viewing your license information

To display your license information, select the "NovaMind / License" option from the menu. You will
see a window like this: 

The following is an explanation of the information you see on the license information panel: 

Name and Company - As entered during the registration process. 

License type - Either single user or for a number of users, or a site license. 

Expires - If this is a temporary license, this shows when it will expire.

Edition Information

Make sure you purchase the most appropriate version of NovaMind for your needs. Information about
the different versions is below, and there is more information on the different feature sets at http://
www.nova-mind.com/Features.

NovaMind Express

http://www.nova-mind.com/Support
https://www.nova-mind.com/Store
http://www.nova-mind.com/Features
http://www.nova-mind.com/Features
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NovaMind Express is the lowest level of NovaMind, and contains all the things you need to get started
Mind Mapping. It does not have all the advanced features of NovaMind Pro and Platinum, like multiple
Mind Maps in a single file, detachable inspector palettes, full screen editing, presentation mode,
screenwriting, project related information, and only has basic import and export capabilities.

NovaMind Pro

NovaMind Pro has many more features than Express, and is designed for the frequent Mind Map user,
and is suitable for general business use. It has the ability to create multiple Mind Maps in a single
document, hyperlinks and checkboxes on branches, more advanced imports and exports, detachable
inspector palettes, and the ability to create your own reusable templates etc.

NovaMind Platinum

NovaMind Platinum is the top of the range Mind Mapping application, designed for serious business
users, project planners, presenters, and screenwriters. It has all the features for project planning and
task information recording, the complete presentation module for doing professional presentations, the
screenwriting module for writing screenplays, and high resolution graphics libraries with up to 8 times
the number of pixels, enabling you to create even more stunning Mind Maps.

3.7 Registering for update information

When you purchase NovaMind directly from the NovaMind application or from the NovaMind web site,
you will be asked whether you want to register for update information and newsletters. 

We respect your privacy and will not disclose your information to anyone or use the information for any
other purposes than NovaMind related messages. 

All messages we send will have a link at the bottom for you to be able to either update your
email Options or to unsubscribe from any subscriptions you may be subscribed to.

Alternatively, you can remove yourself from this mailing list at any time by sending a message with
"unsubscribe" in the title to registrations@nova-mind.com.

4 Adding Items To Your Mind Map

This section of the manual describes how to add new Mind Maps to your document, and how to add
branches, graphics and link lines to your Mind Maps. 

Please see the detail sections for more information on:

Creating Mind Maps using Templates

Adding Mind Maps to your Document

Adding Branches to your Mind Map

Adding Link Lines to your Mind Map

Adding Attached Graphics to your Branches
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4.1 Creating Mind Maps Using Templates

Templates are pre-defined starter Mind Maps that come with NovaMind to help you get started quickly
in creating your own Mind Maps.

When you create a new Document or Mind Map using the NovaMind Application Menu, you will have
the option to select from templates - either choose the "New Document from Template" or "New Map
from Template" option as appropriate:

Also if you are adding a new Mind Map to an existing document, you also have the option to add a new
Mind Map from a template by clicking on the arrow beside the add Mind Map tab:

You also have similar options on the popup menu under New Map in the Insert tab of the ribbon bar.
You will be shown a screen where you can choose the template and theme. A template is like a pre-
made Mind Map, and a theme alters the look of the Mind Map to make it different and interesting.
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On the left is a place for you to select from the different categories of templates available, then in the
center you can choose the template to suit your needs. On the right is a collection of themes that you
can choose to apply to the template. Click on a theme to see how it will look when applied to your
template. If you like the template as originally designed, you can just click the Create button without
selecting a theme, but if you have already selected a theme, you can revert to the original Mind Map by
clicking the No Theme option.

You can create your own templates using the Save As Template option in the application menu. The
template will include all the Mind Maps in the document under the name you choose for the template.

4.2 Adding Mind Maps to your Document

NovaMind Pro and Platinum documents can contain multiple Mind Maps.

There are three ways of adding new Mind Maps to a NovaMind document:

1. Click on the Plus icon beside the last Mind Map tab just below the ribbon bar, or

2. Select the hold the Control key while dragging the tab for the Mind Map to duplicate the map., or 

3. Select a branch and choose the New Map From Branch context menu item to create a new Mind
Map with the selected branch as the title and its children added as children of the new Mind Map.

To delete a Mind Map from the document, just click on X icon on the tab for that Mind Map and it will
be deleted. If the Mind Map is not empty, you will be prompted to confirm that you do really want to
delete the Mind Map.

To re-order the Mind Maps within the document, just drag them into the desired order.
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To copy a Mind Map from one document to another, just drag the tab from one document to the other
one.

4.3 Adding Branches to your Mind Map

This topic describes how to add branches to your Mind Map using the ribbon bar and hotkeys.

Adding branches using the Ribbon bar:

On the Home tab, there is an Insert command group, and it has options for adding a branch (which will
be added as a sibling of the selected branch), or to add a child branch. The shape of the branch is
denoted by the shape of the branch shown on the button. This is determined by the theme if you are
using a theme. If you want to insert a different shape, you can use the arrow at the bottom of the
button to pop up a menu of options from which you can select the branch type to add.

On the Insert tab, you have options to add the different branch types directly with a single click.

On the shape Format tab, there is also an Insert command group which is exactly the same behavior
as the one on the Home tab.

Adding branches using the Suggesterator:

If you have the Suggesterator installed (it is available for free download from the NovaMind downloads
page), and it has some suggestions for branches to add, then they will appear in the Suggesterator
panel. 

To show the Suggesterator panel, click on the little lightbulb icon at the bottom right corner of the
window.

You can select the items you would like to add (hold the Ctrl key while selecting multiple items), and
click the Add Branches button to add the branches. Branches are added as children of the selected
branch. If you would like to have the definitions of the words added to the branch notes for the new
branches, check the Include Definitions checkbox.

If you don't see options that appeal to you, click on the "Give me more!" button to get a different
selection of words.

Adding branches using hotkeys:

You can use the KeyTips to guide you through the options for hotkeys. To activate KeyTips, click the
Alt key. You will see little tags showing you the options for the currently selected area of the user
interface. When you first press the Alt key, you will be shown the key tips for the top level, like this:
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Then when you choose a top level item, you can then choose the detail options etc until you get the
command you want.

So for example to add a new branch, you could use Alt + H + IB, then select the branch type and press
Enter, or you could do it from the Insert tab with Alt + I + CL for a line chld branch.

4.4 Adding Link Lines to your Mind Map

Link lines are used to denote secondary relationships in your Mind Maps. You can add link lines to
your Mind Map by using the Insert tab of the ribbon bar, and selecting the Shape / Link Line option.
When you move your mouse cursor over your Mind Map, the cursor will change to a link line cursor.
Move your mouse over the branch or shape you want to start your link line from, and click and drag to
the desired destination. When your mouse is over a valid destination branch or shape, the line will
change to be black, and when you let go of the mouse button while the line is black, your link line will
be created and selected. You can then alter the shape of the line using the handles.

4.5 Adding Attached Shapes to your Branches

You can add shapes to the selected branches using the following methods:

Using the Ribbon Bar

You can use the Home tab / Insert / Shape option - if you click on the top part of the button, it will add
the pictured shape, which will be the type of shape you last added. You can click on the arrow to show
the options to add other shapes to the selected branch.

On the Insert tab / Shape command group you have options for directly adding any of the graphic
types directly.

On the Shape Format tab, you can use the Insert / Shape option the same as for the Home tab.

Using hot keys

As adding attached text shapes is a common operation, we have made a hotkey for this: Ctrl+Shift+A

Adding Attached Images
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You can also add images as attached shapes by dragging them from the Graphics Library, or from
other programs such as Internet Explorer or the Windows Explorer. If you have a branch selected and
drag the image on to the background, the image will be added as an attached shape, attached to the
selected branch.

If you drag over a branch that is not selected, you can still add that image as the picture for that
branch, although you would need to have the branch selected to add it as an attached shape.

When the graphic is added, if it is a large image, it will be scaled down proportionally so that it doesn't
take a huge amount of room on your Mind Map. If you don't want this to happen, hold the Shift key
while you drop the image.

When you are resizing an attached image graphic, by default the image is scaled proportionally so that
it is not distorted. If you do want to resize the X and Y axes independently, hold the Shift key down
while resizing the image. Note that all resize operations are lossless and the image will be stored full
size in your NovaMind file and printed at the best resolution when printing your Mind Map.

5 Editing Mind Map Design Properties

The following properties relate to the Mind Map itself and its overall look and behavior. These settings
can be altered for a single Mind Map, or for a group of selected Mind Maps in NovaMind Pro and
Platinum, using the Document View.

Please see the detailed topics on:

Using Themes

Using Map Styles

Editing Mind Map Background Settings

Editing Mind Map Layout Settings

Editing Mind Map Color Settings

Editing Mind Map Outline Numbering Settings

Editing Mind Map Task Settings

Editing Mind Map View Settings

5.1 Using Themes

Themes are an excellent way of applying a set of settings to an existing Mind Map. Depending on the
settings for the particular theme, it may include items such as:

· The background of the Mind Map, including background colors and images
· The outline numbering settings for the Mind Map
· The coloring mode for the Mind Map
· The layout assistance mode and branch spacings
· Branch styles for each level of the Mind Map starting from the Mind Map title, through the first level

branches etc all the way down to as many child level branches as are set in the theme. These styles
may include branch shapes, colors, line settings, fonts, etc.

· Attached graphic styles for each level of the Mind Map starting from items attached to the title
through attachments to all the branches.
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· The default branch style for new branches that are created.

When you create a new Mind Map using a template, you will also get the option to select a theme to
apply to it. You can also apply a theme to your Mind Map at any time, but be aware it will apply the
theme settings to your whole Mind Map.

To apply a theme, select the Map Design tab of the ribbon bar, and click on Themes, and select the
theme you would like to apply. There is a live preview so you will see how the theme would look when
applied.

5.2 Using Map Background Styles

Map background styles allow you to set the background image (including tiling, opacity etc) and
background color with a single action.

NovaMind comes with a number of map background styles built in, but you also create your own
styles.

To select a style, go to the Map Design tab and use the Background Styles gallery to select a style to
use for your background. There is a live preview so that you can see what it is going to be like when it
is applied to your Mind Map.

If you want to create your own style, open the gallery by clicking on the down arrow button with the little
line at the top of it, and select the Edit Styles option.

When you do this, you will be put into the map style editor, like this:

To start, either select an existing background style from the gallery, or click the New Style button. You
can then use the Background options to edit the background image and color etc, and then when you
have finished, save your style, and close the style editor.

To delete a Map Background Style

Scroll down to the bottom of the list of map styles in the style selector palette and choose the Browse
Styles menu option. Click on the style you want to delete, and click on the Delete Style button at the
bottom to remove it.
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5.3 Editing Mind Map Background Settings

The Background settings for a Mind Map allow you to set the background color and image for the Mind
Map.

Click on the Map Design tab in the Ribbon Bar and then use the background command to change the
background color or to remove a background image. To see additional options like setting an image on
the background, use the background Dialog Box Launcher for the background (by clicking the box with
the arrow in it at the bottom right of the background Command Group).

These settings can be applied to multiple Mind Maps in your document at once by using the document
view and selecting multiple Mind Maps to apply the settings to.

If you use the dialog box launcher, the full settings panel you see is like this:

Or when viewing the image options:
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To set the background color, use the color picker and choose the color you want.

To select an image for the background, choose the Image from file option and choose the image you
would like to use as a background.

The image will be placed over the background, so if there is transparency in the image, the
background color will show through.

You can change the way the image is tiled by clicking one of the tiling buttons.

You can scale the image by adjusting the image width or height. Normally the aspect ratio of the image
is fixed so that the image scales proportionally, but you can click the link icon on the right side of the
panel to unlink the width and height so that you can stretch the image in one direction or the other. If
you find that you want to go back to the original size of the image, click on the Original Size button.

You can also adjust the opacity of the image to let the background show through more. This is very
useful if your image is too overpowering.

You can also adjust the image position so that the image is in the location you want - if you have the
image tiled, the location you set will be the location of the image under the Mind Map title, and all the
other tiles will move accordingly. 

If you have a background image and want to remove it, just click the No Background Image option.

5.4 Editing Mind Map Layout Settings

The Mind Map layout settings allow you to change the settings for how NovaMind assists with the
layout of the Mind Map.
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These settings can be applied to all the selected maps at once in Document View by using the
document view and selecting multiple Mind Maps to apply the settings to.

The first command is a selection of what layout assistance mode you would like to use - please see
the section of the manual on layout assistance  for a full description of the options for layout
assistance. Click on the top part of the button to toggle to the next state - free -> assisted -> controlled
and back to free layout. If you click on the bottom part of the button, you will be able to select the layout
assistance option you prefer.

To set the actual spacings between the branches, click on the Dialog Box Launcher at the bottom of
the Layout Command Group. You will then see a panel like this:

You can set the layout assistance mode, as well as adjusting the spacings between the branches. 

The spacings shown are applied as follows:

· The first level spacing sets the distance from the center of the Mind Map title to the first level
branches.

· The space between children sets the distance between the branches and their children (except the
distance between the title and the first level branches).

· The repel distance sets the distance between branches and their siblings.

On the right is a live updated preview of how the Mind Map will look with those spacing settings
applied. Click the OK button when you have selected the settings you want.

The Arrange command will immediately apply the spacings you have set to the selected branches. If
you want to auto-arrange the whole Mind Map, just select the Mind Map title.

When "Snap Lines" is turned on in the NovaMind Options, if a dragged branch is aligned with another
branch below or above, a blue dashed line will appear, showing you which branch NovaMind has found
for you to align with. Also if the position is close to equal distance between other branches, lines will be
drawn indicating this, and if you let go at that point, the branch will snap to exact alignment. 

5.5 Editing Mind Map Color Settings

The Mind Map color settings allow you to set the coloring mode for the Mind Map. When you use the
Mode command button, the setting toggles between rainbow and specified colors.

If you select the specified colors option, all the branches will inherit from their parent's color settings
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unless overridden in the branch. If you select the rainbow coloring option, the colors will be set
according to the color wheel and saturation.

If you are using a theme or branch styles,
these will often override the rainbow coloring,
and in such circumstances, you will not see
any change when changing coloring modes.

When in rainbow coloring mode, you will be able to set the angle of the rainbow colors using the
colorwheel.

If you use the Color Mode Dialog Box Launcher, you will also be able to set the intensity of the colors.

These settings apply to all the selected Mind Maps when in Document View.

5.6 Editing Mind Map Outline Numbering Settings

Outline numbers allow you to number the branches on the Mind Map.

Outline numbering always works on the children branches of the selected branch. To turn on outline
numbering for the whole Mind Map, select the Mind Map title and turn on the outline numbering.

To turn on outline numbering, go to the Format tab and use the Numbering command in the Child
Numbering command group.

The Format command allows you to set the map settings for the direction of the outline numbers:

· Starting at the top and going clockwise
· Starting at 3 o'clock and going clockwise
· From the top, down both sides starting with the left side
· From the top, down both sides starting with the right side

The "Child outline numbers top down" option is only relevant if the outline numbering is going
clockwise from the top or from 3 o'clock. If this option is turned on, the child branches on the left side
of the Mind Map title will be numbered from the top down. If this option is turned off, the outline
numbers on the left of the map will be bottom up. For most people, you will want to leave this option
turned on.

Note that when printing or exporting the
outline of the Mind Map, the order of the
branches is set using these outline number
settings (even if the outline numbers are not
shown on the branches at the time).

You can edit the format of the numbers by using the Child Numbering Format for changing different
levels to be letters or Roman numerals rather than numbers. To add to the settings, click on the plus
button, and choose the format for that level. If you want to remove formatting, just click on the down
arrow beside an existing format setting and choose the Delete option, and it will remove the formatting
for that level.

The outline numbers are normally shown before the adornments, but when you are displaying outline
numbers and have adornments on the branches, you can drag them into a different order relative to
the adornments.
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5.7 Editing Mind Map Task Settings

Checkboxes

To show a checkbox on a branch (or multiple selected branches), click on the Show Checkbox
command in the Checkboxes Command Group on the Format tab of the Ribbon Bar. 

If the checkbox doesn't appear, make sure that the checkboxes option is turned on in the View tab.

You can change the state of a checkbox by either clicking on the checkbox itself, or by clicking on the
Checkbox State command, or by selecting the state from the Checkbox State popup.

The "Automatic Checkboxes" setting relates to whether the checked status of the parent branches'
checkboxes is derived from the checked status of their children which have checkboxes shown on
them. As an example, if a branch with a checkbox on it has two children with checkboxes on them,
and the automatic checkboxes option was turned on, the following table shows the possible values:

Child Branch 1 Child Branch 2 Parent Branch

 Unchecked  Unchecked  Unchecked

 Partial  Unchecked  Partial

 Checked  Unchecked  Partial

 Unchecked  Partial  Partial

 Partial  Partial  Partial

 Checked  Partial  Partial

 Unchecked  Checked  Partial

 Partial  Checked  Partial

 Checked  Checked  Checked

If the "Automatic Checkboxes" option is turned off, then the checked state of the parent is independent
of the settings of any of the other branches.

Task Information

For full details on the tasks and resources, please see the separate section on Tasks and Resources
.

5.8 Editing Mind Map View Settings

Scale

Scaling allows you to scale the Mind Map so it fits on the number of pages you want it to. This option is
available on the View tab, and is only enabled when you have the Pages option turned on.

This is useful when setting up for printing, so you can have full control over pagination of the Mind
Map. The Fit to Page option in the pop down menu will fit the Mind Map to a single page.

Note that the page frames as shown are determined by the page size and orientation selected in
the page setup, and the margins you set in the printing setup panel, so if you intend to use
margins other than standard, and need exact positioning of the Mind Map on the page, you
should go into the page setup and select your paper size and orientation, then go into print setup
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and set the margins, and then position and scale your Mind Map exactly as you want it.

Show/Hide

You can show or hide the different attributes of the Mind Map as follows:

Checkboxes Shows or hides the checkboxes on the branches.
Shapes Shows or hides the attached shapes.
Link Lines Shows or hides the link lines that link one graphic

or branch to another.
Boundaries Shows or hides the boundaries around the

branches.
Collapse Symbols Shows or hides the "-" signs which allow you to

hide the children in a single click.
Notes Indicators Shows or hides the indicators on the branches

that show whether there are any branch notes for
the branch.

Outline Numbers Shows or hides the outline numbers as shown on
the branches.

Script Indicators Shows or hides the indicators showing that there
is screenwriting script attached to this branch.

Allocated Resources Shows or hides the people icons indicating where
there are resources allocated to branches.

Progress Shows or hides the pie chart indicating the
percentage complete of tasks.

Priority Shows or hides the priority indicators showing the
priority of tasks.

Zoom

The Zoom command allows you to select the zoom level for your Mind Map. The Fit To Window
command fits your Mind Map so it is all visible in your editing window. Zooming has no impact on what
size the Mind Map will print out - that is dependent on the scale.

6 Selecting branches and shapes

You can select branches just by clicking on them. If you want to add other branches to your selection,
you can either:

· Hold the Shift key or Control key down while you click on other branches and graphics
· Use the menu item "Select Siblings" from the Select control on the Home tab to add all the sibling

branches of the selected branches to your selection
· Use the menu item "Select Children" from the Select control on the Home tab to add all the children

branches of the selected branches to your selection
· Use the menu item "Select Descendants" from the Select control on the Home tab to add all the

children and grandchildren etc branches of the selected branches to your selection
· Hold the Shift key down while you drag a region around the other branches and shapes you want to

add to your selection (see below for details)

You can select multiple branches and shapes by using your left mouse button and clicking and
dragging across the canvas. Your selection area will be colored and as items are selected their
handles will appear to show they are included. Release the mouse button when finished. You can add
to the selection by shift dragging, and control dragging will add items that are not included and remove
ones that are.
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To de-select all the selected shapes and branches, simply click elsewhere in the Mind-Map. To
deselect a single graphic, hold the Control key while clicking on it.

The commands in the ribbon bar operate on multiple selections, so you can select a number of shapes
and/or branches and perform the same operation on them all if you wish.

7 Moving branches

Select the branch and drag it to a new location. You can make fine movements by holding down the
Control key and using the arrow keys. 

When "Assisted Layout" mode is turned on, movement is restricted so as to help you create well laid
out Mind Maps. A copy of the branch will be left at the last acceptable location. If you let the branch go,
it will snap back to that position, unless you have dragged over another branch to begin a graft
operation, or between siblings to reorder siblings. 

When "Snap Lines" is turned on, if a dragged branch is aligned with another branch below or above, a
blue dashed line will appear, showing you which branch NovaMind has found for you to align with. Also
if the position is close to equal distance between other branches, lines will be drawn indicating this,
and if you let go at that point, the branch will snap to exact alignment. 

8 Grafting branches

Grafting a branch is moving a branch from one parent branch to another. 

You can graft a branch just by dragging it on to a new parent branch. You will see a little circle on the
branch - drop the branch when the red fill is in the area towards the children end of the branch to graft
as a child, or in the top sector to graft as a sibling above, or in the bottom sector to graft as a sibling
below. 

9 Deleting branches

To delete a branch, select it, then press the delete key on the keyboard.

10 Resizing branches

The shape of a branch can be changed either from the format tab, or from the context sensitive menus
. Note that for all except the FlexiBranches the text on the branch and the branch itself are

separate, and you can select the text on the branch and make it narrower than the branch if you so
desire. The text below is talking about when you select the branch itself rather than the text on the
branch.

The available branch shapes are: 

Line A line which has the text of the branch above it. When selected, you will have
two handles, one at each end, which you can use for stretching the branch. If
you make it too short for the text, the text will wrap to multiple lines.

Rectangle A rectangle (or rounded rectangle) that may be filled in with color and have a
line around it's border. When selected, you will have 8 handles, one at each
corner, and one in the center of each side to resize the branch. If you make it
too narrow for the text, the text will wrap and make the branch taller
automatically. The text of a rectangle branch can be aligned in the center of the
branch, or at the top or bottom of the branch.
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Oval An oval shape, which can be filled in with a color and have a different color
around the edge, similar to the rectangle. An oval can have the text in the
middle of the oval, or outside the oval above or below, and will wrap and
shorten the size of the oval portion if the branch is made too narrow for the
text.

FlexiBranch A line branch that can be altered in shape using any or all of the six colored
handles. 

Flexi Branches can be shaped in a number of directions and the text is
calculated to space accordingly to try and remain readable (although with tight
angles this will not be possible). By familiarizing yourself with the colored
handles you will learn what each handle allows you to do. 

The red handles allow you to move the start and finish points of the branch.

The orange handles move horizontally and determine the sharpness of the
curve from the straight part of the line at the start (where adornments and
numbering is accommodated) and at the end (where it connects to the next
branch). By moving these further from the red handles you will create a more
gradual curve into the middle of your FlexiBranch. 

The yellow handles can be moved any direction and determine the line shape
which your text is going to follow. The text calculates it's own spacing to try and
overcome crowding, however, on really tight angles crowding can still occur.
You can manually adjust the text kerning (spacing) by selecting the text to be
loosened or tightened and on the Home tab, choose the character spacing
option and either select from one of the predefined options or use the slider to
change it to your desired setting. By also using the purple branch resize
handles you can made the shape wider or narrower - thus creating text
wrapping or unwrapping if desired.

11 Hiding branches

In some circumstances you may want to work with only some of the branches showing, enabling you to
focus on either the main details or the particular portion of the mind map you are working on. 

Note that hidden branches are NOT included in any text searches, spell checks, exported text or
printouts although exporting and printing does have an option where this can be over-ridden by
selecting the checkbox if desired although the branch will still remain hidden on your Mind Map. 

You can hide specific branches by turning on the collapse symbols in the View tab (this will show a
small "-" icon beside the end of each branch). When you click on the icon beside a branch it will hide
the children of that branch.
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12 Branch Options

The following sections tell you about using the Branch related commands. Note that in many ways
branches are just like shapes but with a few other properties.

All of the settings for both branches and shapes can be applied to multiple items at the same time, so
if you want to edit the settings of a lot of branches at once, just select multiple branches at once by
dragging a selection around them, or control-clicking individual branches to add or remove them from
the selection.

For details on the branch specific options, see the sub-topics:

Changing Existing Branch Settings

Changing the Branch Image

Changing the Branch Hyperlinks

12.1 Changing Existing Branch Settings

To change the settings for the selected branches, you can use all the shape format settings on the
Format tab of the ribbon bar.

To change the shape of the selected branches to the desired shape, click on the Shape command in
the Branch Command Group. This will cycle through the branch shapes, or you can choose a specific
shape by using the pull down menu from the Shape command. You can also change the branch shape
from the context menu.

Branch Images

To set an image on the branch, you can use the Shape Fill command on the Style command group of
the Format tab, and choose the image option. This will allow you to select an image file from your
computer. You can drag an image onto the branch from the graphics library or another program such
as the File Explorer or Internet Explorer or FireFox.

You can set whether the text on the branch appears above, below, or centered vertically in relation to
the image by using the Style Dialog Box Launcher to show the Format Shape panel, and the setting is
under the Text settings.

No image data is thrown away in any image resize operation, and will still take up the full
amount of disk space in the NovaMind file, and will print at the maximum possible resolution
given the original image.

Other settings 

In the Format Shape dialog box, you can also set things like the line weight, dashes, and  the line style
of the connection between this branch and its parent. The connection setting is only applicable where
the branch is a second level branch or below.

If you have inserted a boundary, you can use the format settings to set a style for the boundary or use
the fill and line settings for the boundary. In order to do this, click on the line of the boundary to select
it, and then make the changes. In the Format Shape dialog box in the shape section, you can set the
boundary margin (the space between the branch and the boundary).
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If you want to constrain the text width on the branch, you can turn on the Constrain setting, and set the
width - the text on the branch will be automatically wrapped when it reaches the length you specify.

12.2 Using the Suggesterator

The Suggesterator is an optional download to accompany the NovaMind system and when installed,
integrates with NovaMind to propose words to help you build your Mind Map.The suggestions at the
top of the list are closely related to the topic you selected on the Map, and as you go further down the
list, they get further and further "off the wall".

The Suggesterator was designed to help you look for words that are either similar in meaning, opposite
or have some conceptual relationship to the word/s on your selected branch. This can be used to
identify other categories and subjects for inclusion in your Mind Map that you may not have thought of,
keeping momentum and movement in your Mind Map creation, and taking your thinking to new places.
This increases the potential for creating a Mind Map that is more thorough, provides more options and
more considerations depending on your subject. Besides this, it's fun!

For those of you who are more linguistically minded, NovaMind uses random selection from synonyms
and antonyms, chaining through sub-trees of ancestor chains through hypernyms, hyponyms and
meronyms to obtain more semantically obscure suggestions, choosing more closely related items for
further up the list, and items further away to populate the end of the list.

The Suggesterator is only available in English at this time.

If you have the Suggesterator installed on your system, you will see a lightbulb icon at the bottom right
of the window. If it is not showing there, you can download and install it from the NovaMind downloads
page on the website. 

Click the lightbulb to show the Suggesterator™.

You can either select a branch, or type a word to look up the suggestions for. In the list below are the
suggestions that the Suggesterator came up with. If you don't see any you like, click the Give me
more! button for another set of suggestions.

http://www.nova-mind.com/Downloads
http://www.nova-mind.com/Downloads
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The Suggesterator includes all words 3 letters long or more on the branch in its
search.

You can select multiple words by holding down the Control key as you click on the different items to
select them. If you want the definitions of the words included, check the Include definitions checkbox
before you click the Add branches option.

12.3 Branch Hyperlinks

Types of Hyperlink:

The five types of hyperlinks that can be attached to any branch are described below: 

·  NovaMind file 

·  NovaMind Document URL 

·  Local file 

·  URL 

·  Email message 

NovaMind file
This links to another NovaMind document on your local machine. You must specify the name of the file
to open, and you can also specify the title of a branch to select when the file is opened. 

To link to either another branch in the same Mind Map or another branch within the same
document but on a different Mind Map, leave the "Link to NovaMind File" text empty, and enter
the text of the branch you want to select.
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When a user clicks on this type of link, the file will be opened as another document in NovaMind. If you
specify a branch title to select, the Mind Map will be searched in the order that the graphics would print
in that Mind Map, and the first title that exactly matches the link specification will be selected, and
moved to the center of the view of the document. 

Note that if you distribute the NovaMind document to other people, they will not be able to access the
linked document unless it is at the same relative location on their computer. You can specify the
location of a linked file using relative paths - the link needs to start with a . to refer to the current
directory, or .. to refer to the parent directory (relative to the directory where the mind map you are
editing is stored). 

If you want a link to just open a new empty document, instead of typing a file name, type "<NEW>" as
the name of the file to open. 

NovaMind URL
Linking to a NovaMind document on a URL requires full specification of the URL site and the
document name. You may also specify the title of a branch to select when the file is opened. 

When a user clicks on this type of link, the URL will be opened as another document in NovaMind. If
you specify a branch title to select, the opened Mind Map will be searched in the order that the
graphics would print in that Mind Map, and the first title that exactly matches the link specification will
be selected and moved to the center of the view of the document. 

Local file
This links to any file on your local machine and will open that file using the specified default application.

URL
This links to any URL, and will open that file using your default web browser application. 

Email message
This link asks you to specify the recipient of the email, the title of the email and the message. 

When you click on this type of link, the details you specified will be composed in your default email
application. You have the opportunity to edit the message before sending it. An operating system
limitation limits your messages to about 950 characters in length - if the length of the message plus the
title and recipient address it more than 1031 characters, you will receive an error message, and the
link will probably not work.

Note that if you distribute the NovaMind document to other people, they will not be able to
access the linked file unless it is at the same relative location on their computer. You can
specify the location of a linked file using relative paths - the link needs to start with a . to refer
to the current directory, or .. to refer to the parent directory (relative to the directory where the
mind map you are editing is stored). 

Below are a few scenarios showing how to do so.

If you have another file that was called file.txt in the same folder as your Mind Map, you can
refer to it as ".\file.txt". e.g. with a directory structure

C:\Users\you\Documents\YourMindMap.nmind C:\Users\you\Documents\file.txt

If it was in the folder higher by one level in the hierarchy, you would refer to it with "..\file.txt"
e.g. with a directory structure

C:\Users\you\Documents\YourMindMap.nmind C:\Users\you\file.txt
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If it was in the folder below by one level in the hierarchy, you would refer to it with
"OtherFolder\file.txt" or ".\OtherFolder\file.txt" e.g. with a directory structure

C:\Users\you\Documents\YourMindMap.nmind C:\Users\you\Documents\OtherFolder\file.txt

You can combine this to refer to any folder relative paths e.g., the structure below would be
referred to as "..\..\OtherFolder\file.txt":

C:\Users\you\Documents\YourMindMap.nmind C:\Users\OtherFolder\file.txt

When you move the files to a different computer or different parent folder, for the links to
remain valid, you just need to maintain the relative locations of the files e.g. in the second
example you could move the files to:

C:\Users\SomeoneElse\Documents\YourMindMap.nmind C:\Users\SomeoneElse\file.txt

Adding Hyperlinks

You can add hyperlinks to a branch by selecting the hyperlink option from the context menu, or by
using the Hyperlink command on the Insert tab, or by dragging a file on to a branch from the Windows
Explorer, or by dragging a URL from your web browser on to the branch you want the hyperlink on.

The hyperlink panel looks like this:

You can add another hyperlink by using the + button or remove one by selecting it and pressing the -
button.
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You can set the type of the hyperlink to any of the options shown (described above).

You can set the color of the hyperlink icon to differentiate it from the other hyperlinks on the branch by
using the hyperlink color setting.

The options for the specific hyperlink type are shown on the right side of the panel, and are described
above. 

Using the Hyperlink button (or hyperlink context menu item):

The hyperlink settings panel will be shown with a new hyperlink initially set to point to a local file (a file
on your computer). You can then select a specific file to link to or change the hyperlink type as
described below. 

Dragging a file to add a hyperlink:

Drag a file onto the branch you want it linked to, and the hyperlink will be added.

Dragging a URL from a web browser to add a hyperlink:

Drag a URL from your web browser onto the branch you want to have the hyperlink on, and the
hyperlink will be added. Most web browsers have a small icon to the left of the web address which you
can drag. You will be shown the standard panel as above, allowing you to adjust the options for the
hyperlink.

A Note about images:

If you drag an image on to a branch, NovaMind will think that you
want to add the picture to the Mind Map branch, instead of a
hyperlink to it. Therefore for images, you should use the hyperlink
panel to add it.

Editing a Hyperlink

You can edit the hyperlinks on the branch by Control-clicking on the hyperlink. This will display the
hyperlink settings panel and you can edit the settings there.

Deleting a Hyperlink

Select the hyperlink in the hyperlink settings panel, and click the minus button.

Following a Hyperlink

To follow a hyperlink on a branch, just click on the hyperlink.

13 Shape Options

This topic covers editing the attached shapes as well as the graphical aspects of branches. 

Attached shapes are images, text and shapes that are attached to a branch but are not part of the
branch itself. The attached shapes move when the branch moves, but can themselves be moved
independently of the branch. They can be ordered so that they are in front of or behind the branch.
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All of the settings can be applied to one or more shapes and branches at the same time, so if you want
to edit the settings of a lot of shapes or branches at once, just select multiple items by dragging a
selection around them, or control-clicking individual items to add or remove them from the selection.

For details on the graphic editing options, see the sub-topics:

Shape Styles

Line Settings

Fill Settings

  Text Settings
Ordering Attached Shapes

13.1 Shape Styles

Shape styles are a defined group of settings that can be applied to branches and shapes to change
the way they look. This can include things like line colors and line styles, fonts, and fill colors.

Shape styles allow you to set the background image, background color, branch coloring, layout mode,
outline numbering and various other settings with a single action.

NovaMind comes with a number of shape styles built in, but you can edit these, and create your own
styles. Each shape style may set some or all of the attributes mentioned above - these settings are
defined when the style is created.

To apply a shape Style

Select the branches and shapes you want to alter, and use the shape Style gallery to select the style
you want to use.

Note that if you want to apply a style to a boundary, you will need to click on the boundary to select it.
You can still have other shapes in the selection by control-clicking on them. 

The Shape Style Browser

In the style gallery, you can click on the down arrow with the line above it to pop up the full gallery and
menu options. There you will see the option to Browse Styles. When you select this option, a browser
like this will appear:
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Initially, the option "No Filter" will be selected, but you can select whether you want to browse
background styles or graphic (shape) styles, and whether to filter by theme. If you want to filter by
theme and only show the styles as defined in the themes, you can click on a single theme or Control +
click to select multiple themes as shown in the example above.

You can then apply styles to the selected shapes. Note that as this is a floating dialog, you can leave it
showing if you like and use the styles as you format your Mind Map.

Creating Your Own Styles

In the style gallery, you can click on the down arrow with the line above it to pop up the full gallery and
menu options. There you will see the option to Edit Styles. When you select this option, the content of
the window will be changed to look like this:
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If you want to start your definition from an existing style, select it from the style gallery or from the style
browser. If you want to start from scratch, click the New Style button.

You can then use all the formatting options to change the settings of the shape, line styles, fill settings
and fonts etc to be exactly what you want.

The checkboxes indicate the elements of the style that will actually be applied to the shapes when you
apply the style. For instance, if you have the branch type set to line branch, and don't check the Apply
Branch Type checkbox, and then apply the style to a rectangle branch, then it will remain a rectangle
branch. If, however, you did check the Apply Branch Type checkbox, then when you apply the style to
a rectangle branch, it will turn it into a line branch. The same concept applies to all the other settings.

Once you have defined the style, you can save it as a new style, and it will appear in your style gallery
for use as you build your Mind Maps. If you find that it is not doing what you want it to, you can come
into the editor again, and select the style in the browser, and edit it. Then you would just click on the
Save button to update the style.

When you have finished defining your styles, click on the Close Style Editor command.

To delete a shape Style

Select the style you want to delete in the styles browser and click the Delete Style button.

13.2 Shape Outline Settings

You can use the outline settings command to alter the lines on your selected branches and shapes.

The popup menu allows you to set the most common settings of color, line weight, dashes, and corner
styles, and if you need the detailed settings like the amount of rounding on the corners, you can use
the shape dialog box launcher to open the Format Shape window and set the options you need.
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When you select the Default Outline setting, and specified color settings will be removed and the line
will be the default color - inherited from its parent, or rainbow color if you have that branch coloring
mode turned on.

13.3 Fill Settings

You can use the fill settings command to alter the fill for your selected branches and shapes.

The popup menu allows you to set the most common settings of color, removing the fill, or setting a
picture on the branch. Note that the picture setting will allow you to load an image from your computer.
If you want to set an image from the graphics library or from an image on a web page, you will need to
drag the image on to your branch.

When you select the Default Fill setting, and specified color settings will be removed and the fill will be
the default color - inherited from its parent, or rainbow color if you have that branch coloring mode
turned on.

13.4 Text Settings

If your selection includes branches or shapes that have text, the text settings on the Home tab will
allow you to change the settings. The options, by row are:

Font face: click the arrow to pop up the font selection. Each of the fonts is shown in its own font so
you can see what it looks like, and you get a live preview as you mouse over the different fonts. You
can also type in the combo box text area, and the closest matching font name will be chosen.

Font size: click the arrow to pop up the size selection, or type in the size you want, or click in the text
area and use the mouse scroll wheel to increase or decrease the font size. There are also two buttons,
one for making the font larger and one for making it smaller, and they have hotkeys Ctrl+Shift+> to
make it bigger, and Ctrl+Shift+< to make it smaller.

Bold: also accessible using Ctrl+B

Italic: also accessible using Ctrl+I

Underline: clicking this button cycles through no underline / single underline / double underline (also
accessible using Ctrl+U), and clicking the arrow beside the button gives you the additional option of
setting the underline color.

Strikethrough: clicking this button cycles through no strikethrough / single strikethrough / double
strikethrough, and clicking the arrow beside the button gives you the additional option of setting the
strikethrough color.

Character Spacing: allows you to set the spacing of the characters to either one of the preset values
in the menu, or use the slider to set the value explicitly.

Baseline Offset: allows you to set the height of the baseline of the characters to either one of the
preset values in the menu, or use the slider to set the value explicitly.

Font Color: allows you to set the color of the text.

13.5 Corner Settings

Rectangular shapes, boundaries, and rectangular branches can have their corner settings changed.
The basic settings are available in the Shape Outline popup of the Format tab, but if you need to adjust
the amount of rounding for instance, you will need to use the Dialog Box Launcher to open the Format
Shape dialog and change its settings.
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13.6 Ordering Attached Shapes

When you have attached shapes on a branch, you can order them relative to each other and to the
branch by using the Arrange commands on the Format tab, either bringing them one step forward or to
the front, or one step backward or to the back.

14 Tasks and Resources

NovaMind Platinum has the built in capability of keeping track of resources and task information on
your Mind Maps. See the detailed topics below for a full explanation.

14.1 Resources

Resources are anything you want to keep track of during a project. Resources are typically things like:
• Staff
• Contractors
• Meeting attendees
• Tools
• Equipment
• Vehicles
• Buildings
• Meeting rooms
... and anything else you need to keep track of for your project.
 
NovaMind allows you to create a pool of resources that you can use throughout your document on any
of the Mind Maps in the document.
 

Creating your pool of resources
 
You create your pool of resources for your NovaMind document using the resource editor. First, click
on the people icon at the bottom right of the window to show the task information. Now click on the
Manage Resources button.
 
The resource editor looks like this:
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Adding resources
 
You can add resources  by clicking on the + button below the list of resources, and entering the details.
 
You can set the name of the resource, their initials, and their role in the project. You can also set their
standard charge out rate by hour or per use, and their overtime rate.
 
In the Weekly Availability, you can specify how many days a week they are available, or say which
days they are available.
 
In the Daily Availability section, you can set the start and end time - by using the text fields to enter the
24 hour clock start and finish time. The work down time is used to set the amount of non-work time
during the day (e.g. for lunch breaks).

14.2 Resource Assignment

In the Task Information panel, you have all the resources listed under Allocated Resources. To
allocate a resource to the selected branch, just click on the resource in the Allocated Resource list.

You can allocate multiple resources by Control-clicking on other resources, and remove resources
from the allocation by Control-clicking on the resource in the Allocated Resources list. 

When you have resources allocated to a branch, you will see an icon of either a single person or
multiple people. If you hover your mouse over the icon, you will see a list of the allocated resources for
that branch as a tool tip. 
 
If you don't want to show allocated resource indicators on the branches, you can turn this option off in
the view settings.
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14.3 Task Information

There are various types of task related information you can add to branches.
 

Priority
 
You can set the priority to a number between 0 and 9. If the priority is 0, then this is taken to mean that
there is no priority information for that branch.
 
The priority markers are shown on the branches, unless you turn that option off in the view options.
 

Percentage Complete
 
You can set the percentage complete anywhere from -1 to 100. If -1, this is taken to mean that you are
not tracking percentage complete for this branch. If 0%, the full percentage complete pie chart is
drawn red, indicating that the task is being tracked but is not started yet. If 100%, the task is complete,
and is drawn entirely in green. Percentages in between are drawn according to the indicated
percentage.
 
If you don't want the pie chart drawn on the branches, you can turn this option off in the view settings.
 

Duration
 
You can set the duration of a task in whatever unit you choose. If you set a start and finish date for the
task, the calc button is enabled, and when you click the calc button it works out the time difference
between the specified start and finish time, in the units you specify, and enters this in the duration field.
 

Start date
 
If you want to specify a start date, you need to check the Start checkbox.

The date shown will be in the order as set in your calendar preferences in the control panel. You can
either type a date or use the popup date selector to select the date. In the date selector, you can select
the Today option at the bottom to start the task now.
 
If you have a finish date and a duration set, you can click the Calc button to calculate the start time.
 
Today's date is marked in blue.
 
The arrows at the top of the calendar take you forward or back a month at a time. If you click on the
month at the top, it will zoom you out to selecting a year, and when you select a year, it will zoom you
in again to choose the month and day. 
 

Finish date
 
The finish date is exactly the same as the start date, with the exception that the calc button adds the
specified duration to the start date to set the finish date.

14.4 Project Reporting

NovaMind has powerful project/task related reporting built in. To access the project reports, click on
the Project Reports in the Task Information panel.
 
The window looks like this:
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The combinations of searches you can accomplish using this panel is very extensive, so we will just go
through some examples.
 
To search for all the tasks you are tracking the progress of, but which are incomplete, you could put a
check in the Complete checkbox and leave the selection to No. Conversely, if you wanted to see all the
tasks that were complete, you would select Yes.
 
If you wanted to see all the tasks that were assigned to Tania, but were overdue, you would select the
Overdue / Yes options, and the Selected Resources and select Tania's name. If you also wanted to
include Heather's overdue tasks, you could hold the Control key and select Heather too.
 
To see the tasks that are currently partly done, you would select the In Progress / Yes options.
 
And so on - the individual options are pretty self explanatory, and the combination of the options gives
you very powerful search capabilities.
 
In the bottom part of the window you have the search results. To order the results by one of the fields,
just click on the title for that field, and to reverse the sorting, click the title again, and to remove the
sorting, click it a third time.  - for example in the picture above, we have the tasks ordered by priority.

You can also group the results by any of the columns or by a combination of the columns. To group by
a column, just drag the column to the header of the table. For instance, if you wanted to group by
priority, you would drag that column header to the title area. Now if you wanted to group within the
priority by duration, you would drag that column header as a sub-grouping on the title bar of the table.
You can rearrange the levels of grouping by dragging the items around in the title bar, and remove the
grouping by dragging the items off the title bar.
 
You can select one or more of the tasks that are returned as a result of your search and they are
selected on the Mind Map.
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You can leave this panel open, but the results are not updated live - if you have the panel open and
you change the Mind Map, you will need to click the Refresh button.

15 Mind Map Tools

Please see the detail sub-topics covering each of these topics:

Finding Text

NovaMind Outliner

Adornments

Graphics Library

Mind Map Navigator

Branch Notes

15.1 Finding Text

Showing the Find Panel

To display the Find panel, press Ctrl+F. The image below shows the find panel with the additional
options displayed. By default the find searches in all maps in all open documents.

Searching for Text

To search for some text in a Mind Map, first enter the text to search for - either by typing it in, or
pasting the text from somewhere else.
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If you select the option "Current Document", and have several Mind Maps in a single document
NovaMind will search all the Mind Maps in your document. 

If you select to search in all open documents, then NovaMind will also search all other documents you
have open at the time.

The Result table is populated with the search results, and you can select the result you would like to
view by clicking on it.

You can use the find panel to replace occurrences of the text you are searching for either one at a time
or all at once. Just enter the replacement text in the find panel, and use the Replace or Replace All
button. 

15.2 NovaMind Outliner

You can display the outline panel by selecting the Outline View icon at the bottom right of the window.

A whole Mind Map can be built by using the outline panel and allows the user to create, edit and delete
branches as well as copy, paste, graft and rearrange their order.

 The Outline Panel has it's own toolbar with the following functions (from left to right as pictured below):

Add branch, add sibling and delete branch: These are the same icons as those used within the
Mind Map and perform the exact same functions.

Move up and move down: These shift the selected row/s up or down one position, if possible. 

Move left: Moves the selected branch to the left by one level starting with the right most branch. If a
parent has children that are not selected, they will move with the parent while children that are selected
will be shifted left individually. 

Move right: Moves the top selected branches right by one level, if possible. All of the children of any
moved branch will remain in the same relative position. 

Indent: This function is the same as move right. 

Outdent: Shifts the selected branch left by one level, if possible. If a parent and one of its children are
selected, the child will remain a child of the parent after the outdent. 

Group: Creates a new branch and makes all of the selected branches children of the new branch. 

Ungroup: Makes the children of the selected branch into siblings. 

Expand & Collapse One Level: Expands the selected branch by one level showing relevant child
branches. Collapse hides all children by one level. 

Expand & Collapse Completely: Will expand or collapse all the children of the selected branch,
regardless of how many layers there are. 

Expand & Collapse All: This will expand or collapse your entire Mind Map with all the branches on it.

When creating and editing your Mind Map using the Outline Panel, you can use the hotkeys  for
quick functionality such as adding new branches, editing, formatting text etc. By using your mouse you
can group select for various functions as well as click and drag to graft to a new location or re-order
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branches. While dragging to a new location an insert line will appear to indicate a potential position has
been found where it can be grafted, note that the line will move left or right to indicate which indented
position it will be inserted.

15.3 Adornments

What are adornments?
Adornment graphics are small icons that you can attach to any branch and they sit either left or right of
the branch numbering before the branch text. 

Showing the adornment selector
To show the adornment selector, click on the smiley face icon at the bottom right of the window.

Adding adornments to branches
Select the adornment you want to use, and drag it on to the branch. 

Changing the sequence of adornments
If you want to have the adornments in a different order than originally placed on your branch, drag
them into a different order. You can also drag outline numbers into a different position relative to the
adornments. 

Deleting adornments
Delete adornments by dragging them out of the branch (but not on to another branch). Outline
numbers can not be deleted by this method - to remove outline numbers, turn outline numbering off. 

Moving an adornment to a different branch
Drag the adornment to the other branch. 

Creating your own adornments
You can add your own custom adornments under "Custom Adornments". To do this, you will need to
copy the files you want to use into a specific folder, as detailed below. Steps to accomplish this are as
follows: 

Select the images you want to add to your list of adornments. Any image type recognized by MacOS X
will do. The images should all be 16 pixels wide and 16 pixels high. If they are not that size, NovaMind
will resize them to that size when you use them. 

From your home folder, select a folder called Library. Inside this folder, create a folder called
"NovaMind" (if it doesn't already exist). 

Inside the NovaMind folder create a new folder called "Custom Adornments". 

Copy your image files into the "Custom Adornments" folder. If you want to organize your images, you
can also create folders inside the Custom Adornments folder, and these will be reflected in the
adornment selector. 

If you have the Adornment selector open, click the Reload button to refresh the items in the list. 

15.4 Graphics Library

You can show the graphics library by clicking on the picture icon at the bottom of the window. You can
then search for images within your library. 

The graphics section includes all the graphics from your graphics library. The full graphics library
comprises of over 2,300 images in a number of subject categories such as Arrows, Business,
Computers, Education & Science, Food & Drink, News Media & Entertainment, Objects, People,
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Transport and more. Because of the large size of the library, only some images are distributed within
the program, the rest are available by download off the NovaMind Downloads webpage and are free.
Please note that there are separate downloads for Express & Pro, and the Platinum edition, as
Platinum has significantly higher quality images, and has over 900 more images than Express & Pro.
Platinum images will not be recognized in Express & Pro versions of NovaMind.

The graphics are encrypted, and only available for use within NovaMind. When you install the
graphics libraries, you need to restart NovaMind, and then the graphics will appear in the
NovaMind graphics library.

You can use the graphics within your Mind Maps, and can publish Mind Maps with the
graphics on them but you are not allowed to sell or distribute the images on their own.

In the Configuration section, you can add additional directories to load images from so you have easy
access to your images.

Upon finding an appropriate image:

You have the following options:
· Drag the image over an existing mind map branch and the graphic will be applied to the background

of that branch.
· While a branch is selected, drag the image over the canvas and drop to attach it to the selected

branch as a floating attached shape.

15.5 Mind Map Navigator

The Navigator allows you to find your way around large Mind Maps:

The blue rectangle shows the visible portion of the NovaMind document. Click on the area within the
navigation image and your document will scroll to that section. You can also drag the rectangle to a
new location - the document will scroll as you go. 

You can also scroll the document by pressing the spacebar while dragging the background of the mind
map. 

http://www.nova-mind.com/Downloads
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Note also that you can use the arrow keys to select different branches, and they are scrolled so they
are visible. 

15.6 Branch Notes

The branch notes area allows you to edit branch notes. Click on the notes button on the bottom right of
the window to display the notes. You can type notes for the selected branch.

16 NovaMind Presenter

NovaMind has a powerful presentation module built in, yet it is very easy to give a presentation using
NovaMind.

To start your presentation, click on the Presentation Mode command in the View tab.

The ribbon bar will be removed, and you will see the presentation controls at the bottom of the screen.

A Standard Presentation

To start showing your presentation, click the Start button at the bottom of the screen.

First, you will see the Mind map title and the first level branches, expanded to fill the canvas, and
highlighted, with all the sub-branches hidden.

Click the Next button (or press the Space Bar0 to go on to focus on the first branch. The first branch
(as per the outline numbering) is highlighted and expanded to show its immediate children.

As you continue clicking the Next button, the focus continues moving through the branches and sub-
branches, only stopping on the branches that either have children themselves or their siblings have
children. This means that you aren't hopping around all the leaf branches.

Exiting Presentation Mode

When you have finished your presentation, click the Close button at the bottom of the screen to return
to normal editing.

Going Back

At any time during the presentation, you can click on the Back button to focus the previous branch.

Overview

At any time during the presentation you can click the Overview button, which will zoom out so that the
whole Mind Map fits in the window, and all the branches are shown.

Center

At any time during the presentation, you can click the Center button and this will center the currently
focussed branch and zoom it in.

Zooming

You can manually adjust the zoom at any time, but when you are going through the presentation, it will
zoom in to branches as required to highlight them. It only zooms in a certain amount though, otherwise
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the branches would look massive, but if you do want them bigger, just use the zoom control to zoom
in.

Manually Focussing on Branches

You can take over from the normal order of the presentation at any time by clicking on the branch you
want to highlight (even leaf branches that would not normally be individually highlighted). If you click on
a leaf branch which would not normally be highlighted, and then click the Next button, it will continue
highlighting the sibling branches of the highlighted branch until completed, and then go back to the
normal presentation setting.

Editing Branches

You can actually edit the branches while you are in presentation mode. Just double-click on the branch
you want to edit, and start editing. You can add new branches with the Enter and Insert keys as
normal, and then when you want to return to the presentation mode, just either click the Center button
to focus on the previously selected branch, or single click on the branch you want to focus on, and
continue your presentation from there.

Using the Ribbon Bar

Although the ribbon bar is hidden when using presentation mode, you can still access all the ribbon bar
commands by clicking on the tab titles which are still shown at the top of the screen. This will then
temporarily show the ribbon bar to enable you to use the commands you need. It will disappear again
when you have selected the command you need, or when you click on the Mind Map canvas.

If you want the ribbon bar shown all the time while you are in presentation mode, double-click one of
the tab bar titles, and it will show the ribbon bar again. If you want to hide it, you can double-click the
tab again.

17 Context Sensitive Menus

Context sensitive menus are menus that appear when you right-click on different elements within a
NovaMind Mind Map.

There are three different contexts used within NovaMind:

While you are Editing Text

When you click on a Branch  (while not editing the text on the branch)

When you click on the Canvas

17.1 Menus While you are Editing Text

While you are editing text, if you right-click on the text, you will see a number of options like the
following:
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The first item allows you to select the font. The second allows you to select the text size. The rest of
the text options are pretty self explanatory.

The last item is BranchStorm - when you click on this and start editing your branch text, whenever you
press Enter, a little  icon is inserted in the text, and you can continue typing. When you either pause
typing, or finish editing the branch, the text before the first icon is left on the branch, and all the text
between the other  icons is split onto child branches.

17.2 Shape Context Menu

If you right-click on a branch while you are not editing the text of the branch, you will see the following
menu items:

Cut
Copy
Paste

Edit Text (F2) - puts you into edit mode on the selected branch
Edit Branch Notes - switches your sidebar to show the branch notes

Arrange - bring shapes in front of others or the branch, or send them behind

Hyperlink... - show the hyperlink editing panel

New Map from Branch - takes the selected branch and makes it the title of the new map, and adds the
children branches as children of the newly created map title.

Format Shape... - shows the shape formatting panel.

17.3 Background Context Menu

When you right-click on the canvas (i.e. the background where there are no branches or attached
graphics), the following menu is shown:

Snap Lines - this item is checked if you are using snap lines - select this option to turn snap lines on or
off.
Page Frames - shows whether you are showing page frames or not - select to turn this option on or
off.

Format Background - shows the background formatting panel.
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18 Layout Assistance

NovaMind has three different levels of layout assistance to help you with creating great looking Mind
Maps without getting in the way of your creativity. This section describes the options in detail.

18.1 Free layout

Free Layout Mode allows the user to place branches and attachments at any chosen position on the
Mind Map. This option provides flexibility to drag individual branches to any desired position including
the extremities of the page, close to each other etc, however, this mode does not prevent branches
from overlapping. 

18.2 Assisted layout

Assisted Layout mode helps the user to maintain spacing between the branches. The branch spacings
that are maintained in assisted layout mode are those set in the Branch Spacing settings. 

18.3 Controlled layout

Controlled Layout mode arranges all branches and text to create a balanced page centerd around the
Mind Map title. The spacing between branches and siblings is also controlled by the settings on the
layout assistance settings dialog box. Grafting branches is a matter of clicking and dragging to the
desired location - you can not move the branches yourself apart from resizing or grafting them.

19 Canvas size, Zooming and Scaling

You canvas is the area on which you draw your Mind Map. 

Pages Mode

There are two modes you can use when working with your Mind Map. The first is with the Pages option
in the View tab turned off. When creating Mind Maps in this way, you are not worried about how many
pages you are using, as there is an unlimited canvas size that just keeps growing as your Mind Map
requires.

However, sometimes you may need to be concerned about how many pages your Mind Map will print
on, and exactly where your Mind Map will fit on the pages. In this case, turn on the Pages option. Now
the canvas size is in multiples of the page size you set up in your page setup, and takes into account
any margin settings you have set in the print panel (otherwise it uses the default margins for the
printer). While drawing your Mind Map if the branches extend close beyond the boundaries of the
canvas, and extra page is added in that direction.

Zooming

Zooming in enlarges both the canvas and the Mind Map, so you just see the whole thing a different
size. It does not affect the number of pages your Mind Map will take up when printed.

You can zoom in and out by:

· Using the popup menu at the bottom of the document window
· Using the zoom options on the view tab of the ribbon bar.
· Typing in a zoom value in the text field at the bottom of the document window and pressing Enter
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· Clicking in the zoom text field at the bottom of the document window and using your scroll wheel to
zoom in or out.

· Holding down the Control key while scrolling up or down with your mouse scroll wheel

Scaling

Scaling allows you to scale the Mind Map so it fits on the number of pages you want it to.

You can scale by using the commands in the scale section of the Pages command group in the View
tab of the ribbon bar. This is only enabled when you have the Pages option turned on.

When preparing for printing, you can both scale the Mind Map, and move the Mind Map so that the
page breaks occur at exactly the points you want them to.

20 Shortcuts

These topics give you details on the keyboard and mouse shortcuts to make working with your Mind
Map quicker and easier.

20.1 Keyboard

The following are the ordinary keys that have special operations assigned to them in NovaMind: 
 
Arrow keys - When not editing the text of a branch, the arrow keys can be used to select other
branches to work with. The text of the branch is selected so that you can just press Return to edit the
text of the branch. 

Control+Arrow keys - This nudges the selected branch slightly in the direction of the arrow key. 

Delete - Deletes the currently selected branch or graphic (when you are not editing the text) 

Enter - If you have the a branch selected, but are not editing it, pressing Enter adds a sibling branch. If
you are editing, Enter finishes editing.  If you want a new line in your branch text, press Ctrl+Enter. If
you are in BranchStorm mode pressing Enter inserts a marker so you can start typing the text for the
next branch.

Esc - If you press Esc while you are editing the text of a branch, this will end the editing operation
without saving your edits. 

Ctrl+Insert - inserts a picture in the text you are editing.

Ctrl+Click on a branch with an attached Script icon toggles the printing on and off for that particular
script.

KeyTips

Most of the hotkeys in NovaMind are implemented through the KeyTips system on the ribbon bar. You
can use the KeyTips to guide you through the options for hotkeys. To activate KeyTips, click the Alt
key. You will see little tags showing you the options for the currently selected area of the user interface.
When you first press the Alt key, you will be shown the key tips for the top level, like this:
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Then when you choose a top level item, you can then choose the detail options etc until you get the
command you want.

So for example to add a new branch, you could use Alt + H + IB, then select the branch type and press
Enter, or you could do it from the Insert tab with Alt + I + CL for a line chld branch.

Shortcuts using the Control key
 
The following is a list of the other hotkeys for specific operations:

Ctrl+A select all shapes & branches, or select all text while editing
Ctrl+Shift+A create attached text graphic on the selected branch
Ctrl+B bold / unbold text
Ctrl+C copy selected shapes / selected text
Ctrl+Shift+C copy font from selected text
Ctrl+F find
Ctrl+I Italic/Un-italic
Ctrl+L Insert/edit inline hyperlink when editing text
Ctrl+Shift+L Remove hyperlink when editing text
Ctrl+N new file
Ctrl+O open file
Ctrl+P print
Ctrl+S save
Ctrl+Shift+T paste unformatted text
Ctrl+U Underline/Double underline/Un-underline
Ctrl+V paste
Ctrl+Shift+V paste font
Ctrl+X cut
Ctrl+Y redo
Ctrl+Z undo
Ctrl+ < Make selected text smaller
Ctrl+ > Make selected text bigger
Ctrl+Ins Insert a picture at the selected location while editing text
F1 Help
F2 Edit selected branch
Alt+F4 Close currently active window
F10 Show the keytips for hotkey selection (same as pressing Alt)

Shortcuts in the screenwriter window (using the Control key)
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1 Scene
2 Action 
3 Character Name
4 Parenthetical
5 Dialogue
6 Transition
7 Shot
8 Title

20.2 Mouse

The following shortcuts are available in conjunction with mouse clicks: 

Click - select shape 

Drag - move selected shape, or if dragging on the background, does a rubber band selection of
shapes

Shift-Drag (on the background) - adds any unselected shapes in the selection area to the selection

Control+Drag (on the background) - does an XOR selection with the currently selected shapes (if they
were selected, they will be unselected, and vice versa)
 
Control+Scroll wheel - Zooms the Mind Map (makes it look bigger or smaller on the screen without
changing the number of pages it will fit on)
 
Control+Shift+Scroll wheel - Scales the Mind Map (makes it fit on more or fewer pages)
 
Shift+Click - Adds the clicked on shape to the selection

Control+Click - Adds the clicked on shape to the selection if it was not there, or removes it from the
selection if it was there.
 
Shift+Drag (while resizing an attached image shape) - stops constraining the aspect ratio of the image
that is being resized
 
Shift+Scroll wheel - Scrolls horizontally
 
Select+Drag text from another program - copies it onto your text that you drop it on, or creates an
attached text shape if you drop it on the canvas.
 
Drag URL from a web browser to a branch - creates a hyperlink.

Alt+Click on a screenwriter script indicator on a branch - enable or disable it for printing. 

21 NovaMind Options

Options allow you to set the way you want new documents, new Mind Maps, and new branches to
appear, and a number of global options to change the operation of the program.

You can show the Options by selecting the NovaMind Options button from the application menu.

Saving
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If you have "Save Backup Copy" turned on, whenever you save a NovaMind document, the previous
version of the file is saved as a backup. This file has the extension .nmbak - if you have a problem with
your main file, you can rename your .nmbak file to .nmind and open it in NovaMind.

When you have the auto-save feature active, NovaMind will save your Mind Map at the specified
intervals. This is the normal save operation, just the same as if you had used the Save menu option. If
you have not saved the document yet, you will be asked to give the file a name.

Check for Updates
You have three options for checking for updates:
· Only check manually - NovaMind will not ever automatically check for updates - to check for

updates, you will need to come to this pane in the Options and click on the Check Now... button.e
· Check on startup - NovaMind will check for updates in the background, and notify you if there is a

new version available.

If NovaMind finds a newer version, it will display details of the new version and allow you to download
it.

Point releases (e.g. 4.0 to 4.1) are free
updates, but updates that increase by a full
number (e.g. 4.5.2 to 5.0) are paid upgrades,
and you will need to purchase an upgrade
license to use the new version.

Show Snap Lines
Snap lines allow you to more easily line up branches when you are moving them around on the Mind
Map. Check this option if you want to have snap lines turned on.

Keyboard Shortcuts
There are standard keyboard shortcuts available for adding branches and many other common
operations. To change to different options, just click on the item you want to change and type the new
keystroke.

Screenwriting Options
You can set up your standard prefixes and suffixes for screenwriting using this panel:
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- To add an item, click the + button, then type the text using the text field at the bottom of the list
- To remove an item, select it in the list and click the - button
- To edit an item, select it in the list and edit the text in the text field at the bottom of the list

22 Screenwriting

The NovaMind program includes a Screenwriting Module used to write scripts for movies, TV and
plays.

You can display the screenwriting sidebar panel by clicking the S icon at the bottom right of the
window.

Configuration

You can set the overall configuration of the screenwriting configuration in the options panel .

At the bottom of the screenwriting panel there is a configuration button. Click this to show the options
like this:

56
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This panel allows you to set the options for the way dialogues are handled when the dialogue splits
across multiple pages If you have the "Bottom of page" option turned on, the text beside that is put in
the standard position in the page layout indicating that there is more dialog from that person on then
next page.

The "Top of Next Page" setting sets what is displayed at the top of the next page of dialogue - if you
have the checkbox turned on, the text beside it is printed on the top of the next page. If you have the
"Automatic Character Continueds" option turned on, the name of the character that the dialogue
relates to is printed on the next page.

For the Scene Breaks, you can include text indicating that the scene continues on the next page at the
bottom of the page, and text at the top of the next page to show that it is continued from the previous
page. If you have the continued # option turned on, it prints the number of pages the scene covers
after the second page.

22.1 Script elements

A screenplay is made up of a set of elements - the building blocks for creating your script. There are
nine element types as described below. NovaMind makes it easy and fast to write your scripts by
anticipating what element type you are likely to add next and automatically applies it when you press
return or tab.

If you are in an empty element, you can show the element selection panel by pressing Enter then
select the desired element using the arrow keys.

NovaMind also automatically assists with completions of scenes and character names to save
retyping.
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As you can see, the whole thing is designed to enhance the writing experience, minimizing typing,
anticipating your needs and allowing you to keep your hands on the keyboard.

This is an outline of what each Screenwriting element is used for:

Scene This normally is at the beginning of each section of script and gives information on
what the scene location is, the time of day, internal or external location etc.

Action Tells the characters what they are supposed to be doing.
Character
Name

Tells which character is talking/acting.

Parenthetical Tells the actor what kind of expression to use with the dialogue.
Dialogue The script for the character to say.
Transition Describes how the shots change from one scene to another.
Shot Shot indicates a camera angle, shows what is to be emphasized.
Title Script title.
General For recording additional notes for wardrobe, lighting etc.

22.2 Attaching script

You can attach a script to any of the Mind Map branches including the title, it is not possible to create a
script without having a branch selected.

To attach a script, simply select the Mind Map branch where you want to attached it, then click on the
script icon button at the bottom of the window. This will open the script window in "Action" ready for you
to type. For alternate elements either use the drop down list to select one, or use the hotkeys , or
press Enter twice to open the list, or tab and return to cycle through the elements.

22.3 Formatting bar

Within the script window is a formatting bar at the top designed to show you what element you are
currently working in and what element can be obtained next using the Tab or Enter keys. For example,
if you are in Dialogue typing away, and you press Tab, you would be in a parenthetical section,
whereas if you pressed Enter, you would be in Action. 

The next part of the formatting bar has the checkbox for printing which every new script defaults with a
tick in it. This can be unchecked if you want to disable this script and not print or export it. You can also
enable or disable the script for printing by Control-clicking on the screenwriting script icon on a branch.
If it is disabled, then it is shown grayed out on the branch.

22.4 Selecting elements

 As mentioned in the previous section, by using the Formatting Bar you can see what element you are
currently in and which elements you can skip to using Tab or Enter. These elements that are accessed
by Tab and Enter cycle through in logical order according to what normally follows on e.g. Dialogue
always follows Character Name.

There are other ways of changing elements too.

If you use your mouse and click on the currently selected element, it will popup with the full list of
elements so you can use your arrows keys, click on your preferred option and then start typing your
text. You can also use this method to change an existing element type to something different.

Or, by pressing your Enter key in an empty element, your list of elements will open to select from.

You can also use the following hotkeys to skip to different elements...
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Ctrl+1 Scene
Ctrl+2 Action
Ctrl+3 Character Name
Ctrl+4 Parenthetical
Ctrl+5 Dialogue
Ctrl+6 Transition
Ctrl+7 Shot
Ctrl+8 Title
Ctrl+9 General

These hotkeys are only active when you are editing your script (because they are used for other
actions when editing your Mind Map).

22.5 Text completions and prefixes

In your screenwriting scripts, NovaMind has been designed to automatically type repetitive text so you
can save time. This includes character names, parenthetical extensions, transitions, scene prefixes,
scene times, "continueds" and "mores". These text completions are remembered for all scripts in your
Mind Map, not just the active script.

Below is a list of the type of completions NovaMind can perform and how to activate and use each
one. To see a list of the completions available (and edit the lists) please refer to the Screenwriting tab
in your Options. To cancel a completion, press "Esc" to close the popup window and continue typing.

Text Completions - Character Names
NovaMind remembers all character names as you enter them in your script so that in future character
elements it will automatically display them for you.

The completions are automatically shown when you start a character name element, so you can select
from the character names already in the Mind Map. You can also just press Enter to use the selected
name, or type a different character name if you want to use a different one.

As you type, if another character name starts with the same letter NovaMind will popup with a list of
those names, use your arrows to move down the list and press Return on the selected character.

Text Completions - Character Parenthetical Extensions
To activate these extensions, type the character name then press space and open parenthesis (i.e.
" (") and use your arrow and return keys to select from the list e.g. V.O. (means voice over). You can
also edit the list of extensions in your Options panel.

Text Completions - Transitions
In the transition element, the popup will appear as soon as you start the element, so you can select the
required transition, or type your own. To narrow down the completions, start typing the first letter of
your desired transition e.g. "F" which will prompt NovaMind and the popup will appear with all the "F"
options - Fade In, Fade Out, Fade to Black etc. You can also edit the list of transitions in your Options
panel.

Text Completions - Scene Prefixes
When you create a Scene element, initially all the scene prefixes are shown, and you can either select
from them or type your scene name. If as you start typing, your typing does not match a prefix, you will
automatically be shown the scene completions. You can also edit the list of scene prefixes in your
Options panel.

If you start a scene with a prefix, it is correct practice to finish with a suffix. NovaMind will detect the
prefix and will prompt you to insert the suffix at the end of the scene when you press Tab or Return.
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Text Completions - Scene Names
NovaMind remembers previously typed scene names in the same way it does Character Names. After
typing your scene prefix, if you start to type the description of a scene that you have already used in
your script NovaMind will recognise this and will popup with the text for you to select to save re-typing.
Simply continue to type if it is going to be something different to the suggested text.

Text Completions - Scene Time
At the end of your scene, if you press the spacebar "-" spacebar (i.e. " - ") a popup of time completions
will appear e.g. Day, Night, Afternoon, Later etc. You can also trigger this popup by typing your scene
and then press tab. It also automatically appears whe you press Tab or Return in a scene with a prefix.

Use your arrow keys and return to select the appropriate time of day for your scene.

You can also edit the list of scene times in your Options panel.

22.6 Mores and continueds

When formatting scripts, it is part of the industry standard to insert "Mores" and "Continueds" when
dialogue or a scene runs onto a second or subsequent page. NovaMind can do this automatically for
you. Please refer to the Screenwriting tab on the Options Panel  for an explanation of the options
and to adjust these settings to suit so that they will be applied to all new NovaMind scripts.

22.7 Disabling scripts from print and export

The script Control Bar shows a checkbox for "Print". By default, all scripts will be printed unless if you
remove the tick out of the checkbox meaning that particular script will be "disabled" and will not be
included when you send your scripts to print or be exported. Disabled scripts are indicated on your
Mind Map by a faded attached script icon. To "enable" scripts, you will need to put the tick back in the
checkbox.

You can also hold down the Ctrl key and click on the script icon to toggle printing on and off.

There is a checkbox under the print and export settings to "Include All Script (even if
disabled for printing)" which will override whatever settings you have made. This is a easy
way to print everything without having to go through checking and unchecking script boxes.

22.8 Screenwriting standards

NovaMind Screenwriting has been designed according to the American movie industry standards.
These Standards are outlined below and are set for printing onto US Letter size (8.5x11"). NovaMind
also supports A4 size paper by adjusting the margins but leaving the layout of the text compliant with
the standards.

The font used is Courier Final Draft Regular 12pt. If this is not available on your system, it will default
to Courier 12pt.

The following screenwriting elements are supported:

Scene Heading Upper case, left aligned, 2 blank lines beforehand, 61 chars wide.
Action Mixed case, left aligned, 1 blank line beforehand, 61 chars wide.
Character NameUpper case, left aligned, 1 blank line beforehand, 21 chars indented, 61 chars wide.
Parenthetical Mixed case, left aligned, no blank line beforehand, 15 chars indented, 24 chars wide

including ().
Dialogue Mixed case, left aligned, no blank line beforehand, 11 chars indented, 35 chars wide.
Transition Upper case, right aligned, 1 blank line beforehand, 42 chars indented, 16 chars wide.
Shot Upper case, left aligned, 2 blank lines beforehand, 61 chars wide.
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Title Mixed case, center aligned, 1 blank line beforehand, 61 chars wide.
Page Number Numeric, right aligned, no blank line beforehand, 59 characters indented, 4 chars

wide.

23 Contacting NovaMind

This topic covers the various ways to contact NovaMind.

23.1 Web site

The NovaMind web site address is: www.nova-mind.com

If there are any issues with the web site, please send an email to: webmaster@nova-mind.com

23.2 Email

In most cases email is the best way to reach us.

General information: info@nova-mind.com

Sales enquiries: sales@nova-mind.com

Technical support: support@nova-mind.com

Subscribe / unsubscribe for news updates & newsletters: registrations@nova-mind.com

Contact the Newsletter Editor: news@nova-mind.com

23.3 Post / physical address

Our physical address is:

6/66 Commercial Drive
Shailer Park
QLD 4128
Australia

Our postal address is:

PO Box 4503
Loganholme DC
QLD 4129
Australia

23.4 Sending feedback

Please use the "Help / Send Feedback" menu item. We are committed to making NovaMind the best
possible, and are keen to get your feedback.

23.5 Reporting a defect

Please use the "Help / Send Feedback" menu option, and fill in as much information you can about the
nature of the problem and how to reproduce it. We want to hear about any fault you find, no matter
how small, and will aim to fix it promptly. 

http://www.nova-mind.com
mailto:webmaster@nova-mind.com
mailto:info@nova-mind.com
mailto:sales@nova-mind.com
mailto:support@nova-mind.com
mailto:registrations@nova-mind.com
mailto:news@nova-mind.com
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Also if you experience a crash, we have built in a crash reporter that allows you to send the relevant
information to us so that in many cases we can see exactly what happened so we can fix the issue
quickly. Please include your email address so we can contact you if necessary.

23.6 Checking for updates

Connect to the Internet and use the "Help / Check for Update" menu item. You will be shown
information about any application updates that are available. You can also have NovaMind
automatically check for updates - this is set up in the Options panel .

You can download and install new versions of NovaMind from our web site. 
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